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1. Introduction 
 

1.1 Sequential Conditional Probability Ratio Tests 
 

A clinical trial is usually designed to detect a given difference in parameters of 
interest with given power and significance level. The sequential designs of clinical 
trials allow a trial to be stopped early when data collected at an early stage of the 
trial have produced enough, in one sense or another, evidence for the conclusion 
of testing about the hypotheses.  
 

Different sequential designs are available for the same requirement of significance 
level and power. On the other hand, the same set of observed data can be 
interpreted as outcomes of different sequential designs with the same significance 
level and power. Therefore for the same observed data, the conclusion of a test 
may be significant by one sequential design but insignificant by another. This 
phenomenon may lead to the question that whether applying sequential test 
design to clinical trials is rational.  
 

Withstanding this challenge, the sequential conditional probability ratio test 
(SCPRT) proposed by Xiong (1993, 1995) offers a special feature, i.e., a 
conclusion made at an early stopping is unlikely to be reversed if the trial were not 
stopped but continued to the planned end. The SCPRT gives a sound reason to 
stop a trial early: i.e., if the trial were not stopped as it should be, adding more data 
and continuing the trial to the planned end would not change the conclusion. With 
an SCPRT procedure, a sequential clinical trial is designed with not only given 
significance level and power, but also with a given probability of discordance, 
which controls the chance that a conclusion made at an early stage would differ 
from that at the final stage of the trial.  
 
1.2 Computer Program for SCPRT 
 

This computer program is created for the design procedure of SCPRT on 
Information time, which is generally applicable to designs of clinical trials in which 
the sequential test statistics can be approximated by a standard Brownian motion 
on information interval [0, 1]. Implemented on Microsoft Windows, this computer 
program is interactive, intuitive, and simple to use. This computer program is 
initiated, designed, and coded in Compaq Visual Fortran by Dr. Xiaoping Xiong.  
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You may copy the executable file of this computer program to any directory of your 
computer with operating system MS Windows XP, and then start the program by 
double clicking the executable file.  In the front page of the program, click button 
Start Program to open the main dialog box SCPRT on Information Time, in which there 
are 5 numbered panels: 

1. Choose Design 
2. Fixed Sample Test Design 
3. Sequential Test Design 
4. Graphic Display of Design  
5. Operating Characteristics  
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The design procedure proceeds from panel 1 to panel 5:  
 

 In the 1st panel Choose Design, you may choose one of three designs: 1) Fixed 
Sample Test; 2) SCPRT for Normal Outcomes; 3) SCPRT on Information Time. The 
default choice is 2. 

 In the 2nd panel Fixed Sample Test Design, you may design a fixed sample test for 
a one-sided test. The fixed sample test has 5 parameters: 1) the standard 
deviation, 2) the alternative, 3) the significance level, 4) the power of test, and 
5) the sample size.  You need to specify values for any four of the five 
parameters, and then calculate the remaining parameter by clicking its button. 
If you want to design a sequential test and had selected SCPRT for Normal 
Outcomes or SCPRT on Information Time in the 1st panel Choose Design, you still 
need to enter parameters in the 2nd panel as above before you proceed to the 
3rd panel. 

 In the 3rd panel Sequential Test Design, you design a sequential test (SCPRT) 
after you had made choices in the first and second panels. You choose a value 
for the number of looks and then click the button Enter Group Sizes or Enter 
Information Times to open a dialog box. After entering information into this dialog 
box, close the box and then click the button Bound-Coeff to calculate the 
boundary coefficient “a” and the maximum probability of discordance (ρmax). 
The maximum conditional probability of discordance “rho” (or ρ) is specified 
with a default value of 0.02. You can change “rho” to other values, but 
remember to click the button Bound-Coeff to update “a” and “ρmax”. 

 In the 4th panel Graphic Display of Design, you can graphically display the 
sequential boundaries, the power function, and the expectation function of the 
design that you specified in the third panel. You first click the button Sequential 
Design to calculate the actual significance level and power of the sequential 
design, then click the button Graphic in the sub-panel Window to open a graphic 
window labeled Graphic Window: Plotting. In the graphic window, you can select 
Applications → Plot Design… → Sequential boundary or Power function or Expected 
sample size to display the plot of selected item. 

 In the 4th panel, you can also simulate sample paths and display them in the 
graphic window. From the main dialog box, click the button Simulated in the 
sub-panel Select Samples to open a dialog box Setting Simulation. In this dialog 
box, click the button Select Set repetitively until the desired number of records is 
displayed, and then click Simulate and then Done to close this dialog box. You 
return to the graphic window and select Applications → Plot Samples… → By 
simulation to display the simulated samples overlaying on the sequential 
boundaries of design made in earlier panels. 
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 In the 5th panel Operating Characteristics, you can display the numeric results of 
characteristics of the sequential design specified in earlier panels. You click 
one of the four buttons: 1) Critical Boundary Values; 2) Probability of Discordance; 3) 
Probability of Significance; 4) Expected Sample Size to open a dialog box displaying 
information about the selected item. 

 
1.3 Applications with this computer program 
 

This program is applicable to designs of any study for which the sequential test 
statistic behaves stochastically as same as or approximately as the Brownian 
motion on the (information) time interval [0, 1]. The sequential procedure for one 
population with normal distribution is imbedded easily into the SCPRT 
procedure for Brownian motion; the procedures are illustrated in Sections 2 to 6. 
Though only the one-sided test is illustrated this program, the two-sided test 
with significance level  and power 1  can be implemented by utilizing a one-
sided test with significance level 2/  and power 1 . Let 

kt
S  be the sequential 

test statistic at the kth look with information time kt  for a one-sided test. A two-sided 
sequential test is accomplished through a procedure of performing two one-sided 
sequential tests simultaneously with 

kt
S  and 

kt
S  sharing common sequential 

boundaries of one-sided test.  The procedure of two-sided sequential test stops 
when, for the first time, either one of the one-sided tests has reached the 
significance (across upper boundaries) or both of the one-sided tests have 
reached the futility (across lower boundaries). This sequential procedure is 
appropriate in particular to compare the means of two populations even when the 
distributions for which are not normal. In most situations, the distribution of the 
difference between samples from two populations approximates well to the normal 
distribution even when sample sizes are very small. Thus the stochastic process 
induced by sequential test statistic approximates well the Brownian motion on all 
information times setting on [0, 1]. For normal, binary, and survival populations, 
the procedures for comparison of two populations are illustrated in Section 7, 
and the procedures for comparison with historical population are illustrated in 
Section 8. For each sequential test design, a fixed sample test is designed first for 
given significance level and power and other requirements; then an SCPRT 
sequential procedure is developed based on the fixed sample test design. For 
designs in Sections 7 and 8, the sample sizes of fixed sample tests can be either 
obtained using any other software, or be calculated using equations provided there 
in this manual. 
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2. A Starting Example 
 

“Show me an example”, you might ask. Yes, we certainly do, because it is usually 
easier for anyone to learn from examples. You will have a good experience of this 
computer program after you walking through the starting example, with your hands 
on the computer program and following the steps illustrated in this section. 
 
Hands on example to help get you started. 
 

2.1 A Fixed Sample Test 
 

The SCPRT design is started with a design of a fixed sample test for testing 
hypotheses  

H0: μ ≤ 0    vs.    Ha: μ > 0 
Suppose you want to detect an alternative μa=0.4 with a significance level α=0.025 
and power 1-β=0.9, assuming the standard deviation of observations is σ =1.5. In 
the 1st panel, click the button SCPRT for Normal Outcomes. In the 2nd panel, enter 
0.025 for Sig-level, 1.5 for Std Deviation, 0.9 for Power of Test, and 0.4 for Alt. Mean 
mu_a =, and then click the button Sample Size m =. The sample size for this design 
will be calculated as m=147.7. 
 
2.2 Number of Looks, Group Sizes, and Information Times 
 

The sample size for the fixed sample test is m = 148, a rounding-off of 147.7, and 
is also the maximum sample size of the sequential test. Assume you want to have 
five interim looks and the final look (six looks in total) when the cumulative sample 
size reaches 25, 50, 75, 100, 125, and 148 in the sequential procedure. In the 3rd 
panel, enter 6 for Number of Looks, and then click the button Enter Group Sizes to 
open a dialog box labeled Information Times as below. In this dialog box, you 
change the sizes for the first two groups from 24 to 25, and then click the button 
Update Changes. The updated cumulative sample sizes and information times of 
looks will be presented in this dialog box. You may click the button Keep Change 
before closing this dialog box; otherwise the sample sizes or information times will 
take default values when you reopen this dialog box. To cancel the effect of Keep 
Change when you reopen this dialog box, just click Default Entry and close and then 
reopen the dialog box. After finishing with this dialog box and returning to the main 
dialog box SCPRT on Information Time, you need to click the button Bound-Coeff a:  to 
update or calculate the boundary coefficient a=3.33185 and the maximum probability 
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of discordance ρmax=0.0053; otherwise subsequent calculations will be based on an 
incorrect value of boundary coefficient a. 

 

 
 
2.3 Sequential Boundaries 
 

In the 4th panel, click the button Sequential Design to calculate the significance level 
and power of the sequential design, which are α = 0.0258 and 1-β = 0.8994. Click the 
button Graphic to open a graphic window Graphic Window: Plotting. In this window, 
you select Applications → Plot Design… → Sequential boundary from drop-down 
menus to open a small dialog box Plot.  

 

 
 

Click the button Refresh Plot in this dialog box, the system will plot the sequential 
boundaries as shown below. Some of the design parameters and operating 
parameters such as information times and critical P-values for upper and lower 
boundaries are reported in this plot. To close the window, you may select File → 

Close from drop-down menus, or click the button - in the right upper corner of the 
window, or click the button Close in the 4th panel of the main dialog box SCPRT on 
Information Time, to minimize the window. Do Not click the button x in the right 
upper corner of the window to kill it because once the window is killed, it cannot be 
reopen. 
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2.4 Power Function 
 

In the window Graphic Window: Plotting, select the following from the drop-down 
menu: Applications → Plot Design… → Sequential boundary to open a dialog box 
labeled Plot. Clicking the button Refresh Plot will display a plot of power function as 
shown below. 
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2.5 Expected Sample Size 
 
In the window Graphic Window: Plotting, select the following from the drop-down 
menu: Applications → Plot Design… → Sequential boundary to open a dialog box 
labeled Plot. Click the button Expected sample size to display a plot of power function 
as shown below. 

 

 
 

2.6 Simulating Sample Path 
 
In the 4th panel of the main dialog box, click the button labeled Simulated (in sub-
panel Select Samples) to open a dialog box labeled Setting Simulation as below. 
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In this dialog box, click the button Select Set once after selecting mu = 0.40, and then 
click Select Set once again after selecting mu = 0.0. You see Record # k = 2 which 
indicates that two sets of data have been selected for simulation. One set of data 
will be simulated with true mean = 0.40 (i.e., under Ha), and the other set of data 
will be simulated with true mean = 0.0 (under H0). Click the button Simulate and 
then close this dialog box by clicking the button Done. In the window Graphic Window: 
Plotting, select the following from the drop-down menu: Applications → Plot 
Samples… → By simulation. The dialog box shown below is displayed.  
 

 
 

Select the button Saved and then click the button Refresh Plot, the system will 
display a plot of two simulated sample paths laying over on sequential boundaries 
as shown below.  By selecting the button New in the dialog box, you can simulate a 
series of new sample paths by clicking the button Refresh Plot repetitively. 
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3. Procedure for SCPRT Design  
 
The procedure of SCPRT design using this computer program can be summarized 
as the following main steps. 
 
3.1   Select type of sequential design 
 

In the 1st panel:  
1) Select the design of your choice 

 
3.2   Step one: Design a fixed sample test 
 

In the 2nd panel:  
1) Enter your chosen values for any 4 of 5 parameters. 
2) Click the button of the 5th parameter to calculate its value.  
3) Anytime you make any changes by 1), remember to redo 2). 

 
3.3   Step two: Set information time 
 

In the 3rd panel:  
1)  Enter number of looks. 
2) Click button Enter Group Sizes or button Enter Information Times to open a 

dialog box labeled Information Times, then enter group sizes or information 
times into the dialog box. 

3) Click Update Changes in the dialog box to update the sample size for the last 
group and information times for all looks. 

4) Optional: Click Keep Changes to preserve the group sizes and information 
times in case of accidentally reopening this dialog box. To cancel the effect 
of Keep Changes when reopening the dialog box, click Default Entry and close 
and then reopen the dialog box.  

5)  Click OK to close the dialog box. 
 
3.4 Step three: Control sequential boundaries 
 

In the 3rd panel again:  
1) Enter value for “rho”, the maximum conditional probability of discordance (ρ); 

its default value is 0.02. 
2) Calculate the boundary coefficient “a” by clicking the button Bound-Coeff a. 
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3) If the maximum probability of discordance (ρmax) is too small or too large, 
change “rho” in 1), and redo 2) until you are satisfied with ρmax. 

 
3.5 Check sequential design 

 

In the 4th panel: 
1) Display the significance level and power of test for the sequential design by 

clicking the button Sequential Design. 
2)  Open this graphic window by clicking the button Graphic. 
3) Display boundaries, power functions, and expected sample sizes by clicking 

drop-down menu Applications of the graphic window and then select Plot 
Design… . 

 
3.6 Get numeric values of sequential design 

 

In the 5th panel: 
1) Click Critical Boundary Values to open a dialog box from which you can obtain 

information time, sequential boundaries, and critical P-values for any look k. 
2) Click Probability of Discordance to open a dialog box from which you can 

obtain the maximum probability of discordance and the probabilities of 
discordance for any value of the mean parameter.  

3) Click Probability of Significance to open a dialog box, from which you can 
obtain the probability of significance (i.e., the probability to reject H0) for any 
value of the underlying mean parameter, including the significance level at 
mu = 0 and the power of test at mu  = mu_a. This is the power function. 

4) Click Expected Sample Size to open a dialog box from which you can obtain the 
expected sample size and expected information time for any value of the 
underlying mean parameter.  

 
4. Characteristics of Sequential Design 
 

4.1 Sequential Boundaries and Critical P-values 
 

The original test statistic at kth look is 
kn

S , the sum of first kn  original observations 

Kn
XX1 . The standardized test statistic is *

kt
S , obtained by dividing 

kn
S  with the 

standard deviation of 
Kn

S  at the final stage K. For practical convenience, the upper 
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and lower sequential boundaries can also be represented in terms of critical P 
values.  

 
 

The sequential test statistic has crossed the boundary and the sequential test 
should be stopped if the observed P-value (for 

kn
S  or *

kt
S  as a fixed sample test at 

kth look) is either smaller than the critical P-value of the upper boundary or larger 
than the critical P-value of the lower boundary. Click Critical Boundary Values in the 
5th Panel to open a dialog box as shown above. In the panel Upper Boundary 
(Significance) of the dialog box, the upper boundary for 

kn
S  is Boundary Value 47.236 

when Interim (or Final) Look k = 5 in the panel Sequential Stage; the upper boundary for 
*

kt
S  is Std Boundary Value 2.5906; the critical P-value is 0.0024. The lower boundary 

values can be obtained similarly from the panel Lower Boundary (Futility).  By 
changing the Interim or Final Look k in the panel Sequential Stage, the boundary 
values and critical values can be obtained for different look k’s.  
 
4.2 Probability of Discordance   
 
When a sequential test is stopped on the basis of partially collected data, two 
questions naturally arise: “Is this conclusion as reliable as the one drawn from all 
data?” and “Would the conclusion have been reversed if the trial had not stopped 
but continued to the planned end?” The probability of discordance is a quantitative 
measurement for answering this question. Click Probability of Discordance in the 5th 
panel to open a dialog box as below. 
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In the panel Probability of Discordance of the dialog box above, the (overall) 
probability of discordance is rho (true mean) = 0.00278 when mu = 0.4 in the panel True 
Mean. The discordance between conclusions of sequential test and the fixed 
sample test results from two situations: 1) the sequential test is significant and the 
fixed sample test is futile (or insignificant), which is named as At Significance; 2) the 
sequential test is futile (or insignificant) and the fixed sample test is significant, 
which is named as At Futility. In the dialog box above, rho (true mean) = 0.00081 for At 
Significance, rho (true mean) = 0.00198 for At Futility, and the sum of the two 
components equals the overall rho. The probabilities of maximum discordance are 
the probabilities of discordance when true mean mu = 0.24166 (delta = 1.95996 = zα ) , 
and can be obtained by clicking the button rho_max in the dialog box. The delta in 
the panel above is the drift parameter of Brownian motion, and also the mean of 
standardized test statistic at the last stage, i.e., delta = )(

Kt
SE = m1/2mu/σ. The mean 

mu, the standard deviation σ, and the sample size m are those entered or 
calculated in the 2nd panel of the main dialog box. 
 
4.3 Probability of Significance 
 
The significance level is the probability of rejecting H0 when the true mean = 0; the 
power of the test is the probability of rejecting H0 when the true mean = mu_a. The 
power function is the probability of rejecting H0 as the function of the true mean. 
The significance level and the power of the test are two special values of the 
power function when the true mean equals 0 and mu_a, respectively.  
 
In general, the significance level of SCPRT design is slightly higher than that of the 
fixed sample test design, and the power of the test for SCPRT is slightly lower 
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than that of the fixed sample test. In the example in Section 20, the significance 
level is 0258 for the former and 0.025 for the latter, and power is 0.8994 for the 
former and 0.90 for the latter. The entire power functions of sequential test design 
and the fixed sample test design are very close. It can be shown that the 
difference between the two power functions is less than the probability of 
discordance for any true mean and thus is less than the maximum probability of 
discordance ρmax. Click Probability of Significance in the 5th Panel to open a dialog 
box as shown below. 

 

 
 

In the panel Probability of Significance of the dialog box above, the significance level 
Prob = 0.0258 by k = 6 is obtained by entering mu = 0 in the panel True Mean. The 
power of the test Prob = 0.8994 by k = 6 is obtained by entering mu = 0.4. The 
probabilities that the sequential test to stop at or by the kth look are in the panel 
Probability of Stopping. For example, let mu = 0.4 in the panel True Mean and let k = 5 
in the panel Sample Size at the kth look, then the probabilities of stopping Prob = 0.2248 
at k = 5 and Prob = 0.6023 by k=5 are presented in the panel Probability of Stopping.  
 
4.4 Expected Sample Size and Expected Information Time 
 
The sample size of a sequential test is random, not predetermined. Therefore the 
efficiency of sequential tests is usually judged by their expected sample sizes such 
that a smaller expected sample size means greater efficiency. However, a 
sequential design with a larger maximum sample sizes usually has a smaller 
expected sample size. For example, the Wald’s SPRT has the smallest expected 
sample size, but it has the largest maximum sample size which equals infinity. The 
SCPRT has the smallest maximum sample size which equals the sample size of 
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fixed sample test, and its expected sample size is a little larger than that of Wald’s 
SPRT. Click Expected Sample Size in the 5th panel to open a dialog box as below.  
 

 
 

In the panel Expected Sample Size of the dialog box, the expected sample size is E(N)  
= 115.9 and the expected information time is  E(T)  =  0.78275 when mu = 0.4, where 
E(T)=E(N)/m and m is the maximum sample size. Given that the result of test is 
Significance (i.e., the sequential test statistic has fallen into the rejection region of 
H0), the conditional expected sample size is E(N|sig) = 113.3  and the conditional 
expected information time is E(T|sig) = 0.76561.  Given that the result of the test is 
Futile (i.e., insignificant, or the sequential test statistic has fallen into the 
acceptance region of H0), the conditional expected sample size is E(N|Fut) = 138.4 
and the conditional expected information time is E(T|sig) = 0.93506. By clicking 
Special Values repetitively, the expected sample sizes and information times will be 
calculated in sequence for special values of true mean: mu = 0 (mu_0 = 0), mu = 0.4 
(mu_a = 0.4), and mu = 0.24166 (delta = 1.95996 = zα ) . 
 
5. Simulation of Sample Paths 
 

For a statistical inference problem in reality, observations are sampled from an 
unknown distribution or a distribution with unknown parameters. By statistical 
analysis, the distribution or its parameters are estimated from the observations. 
Simulation is opposite to the statistical inference, in which the true distribution or 
its parameter is assumed known and observations are simulated or artificially 
sampled from this distribution. It can be viewed that the observations in a 
statistical inference problem in reality are simulated by nature which has used a 
distribution to do simulations but hided the true distribution or its parameters away 
from our knowledge. 
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This computer program provides the functionality of simulation by which users can 
simulate observations in different situations (e.g., under H0 or under Ha). The 
simulation helps users to understand intuitively the stochastic behaviors of 
sequential test statistics over the sequential boundaries of various designs and 
simulation parameters chosen. 
 
5.1 Setting Parameters for Simulation 
 
Click the button Simulated in the sub-panel Select Samples of the 4th panel to open a 
dialog box as shown below. 
 

 
 

In the dialog box above, click the button Select Set to select a number of data sets 
for simulation. For a data set to be selected, the number of observations in this set 
is specified by n =; the mean parameter of observations in this set is specified by 
mu = or delta =; the ordinal number of this set is specified by Record #: k =. You can 
delete a selected set by clicking the button Delete Set. After a set is deleted, the 
ordinal numbers of selected sets will be updated and reassigned to the remaining 
sets. The design parameters except the mean parameters used for simulation are 
that set previously in the 2nd panel Fixed Sample Test Design in the main dialog box. 
If you made changes in the 2nd panel and want to simulate data sets with new 
parameters, you need to click the button Reset in the dialog box and restart the 
selection process for simulation. The total number of sets selected is indicated by 
Number of Selected Sets which is gray until you click the button Simulate to make it 
black. By clicking Simulate, the data sets are simulated and ready for being 
displayed and/or saved. 
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5.2 Simulating Samples and Interpreting Results 
 
After having selected sets as explained above, click Graphic in the 4th panel of the 
main dialog box to open a graphic window labeled Graphic Window: Plotting. Select 
the following from the drop-down menu: Applications → Plot Samples… → By 
simulation to open a dialog box Plot Simulation.  

 

 
 

If the radio button New is selected each time you click the button Refresh Plot, new 
sets of sample paths will be simulated and plotted in Graphic Window: Plotting. If 
Saved is selected each time you click Refresh Plot, the saved set of sample paths 
will be plotted in Graphic Window: Plotting. The mean parameters of those paths are 
those set by the dialog box Setting Simulation (Section 5.1). For simulation example, 
assume 30 sets are selected (hence k=30) and mu = 0.4 is selected as the mean 
parameter for each of them. The simulated 30 sample paths are plotted in the 
figure below. The colors of the first 10 sample paths are listed to the left of the 
figure. 

 

 
 



 

 

20 

20 

For another simulation example, assume 30 sets are selected with mu = 0 as the 
mean parameter for each of them. The simulated 30 sample paths are plotted in 
the figure below.  

 

 
 

For the two simulation examples above, significance level α =0.025 and power of 
test 1-β=0.9 (hence β=0.1) were set. Under Ha (mu=0.4), the number of simulated 
paths failed to reach significance (i.e., with endpoints below cutoff value zα = 1.96) 
at the planned end (information time t=1.0) is random, on average, it equals k×β = 
30×0.1 = 3.  Under H0 (mu = 0.0), the number of simulated paths that falsely 
reached significance (i.e., those with the endpoint above cutoff value zα = 1.96) at 
the planned end (information time t = 1.0) is random, on average, it equals k×α = 
30×0.025 = 0.75. You may repeat the two simulations many times and check if the 
numbers of paths ending above (or below) zα = 1.96 is about 3 (or 0.75) in average 
for the first (or the second) simulation example. 

 

A major concern regarding early stopping of clinical trials is the possible later 
reversal of the early conclusion. Suppose a trial could be stopped according to the 
sequential design and the partially collected data, but the trial was not stopped and 
continued to the planned end. The conclusion of a test carried out with all data 
could be opposite to that of a sequential test at the earlier look. As shown in the 
figure below, the sequential test statistic crossed the upper boundary at the 3rd 
look with the first 75 observations and hence, the test should be stopped with a 
conclusion of significance. Suppose the trial were not stopped as it should have 
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been, but had continued to the planned end and stopped at the 6th look with 148 
observations. The test statistic crossed the lower boundary at the 6th look, and 
hence the test should be concluded with finding of insignificance. This is a typical 
example of discordance between the conclusion at an early stage drawn from 
partially collected data and that at the planned end drawn from full data.  

 

 
 

For an SCPRT design, the probability of discordance depends on the true mean 
mu, and is maximized at the mu (μ) that its standardization delta ( ) is equal to the 
cutoff value (i.e., delta = zα). You may obtain this value of mu or delta for each 
design by clicking Probability of Discordance in the 5th panel of the main dialog box 
and then clicking rho_max in the dialog box Probability of Discordance.  
 
In the dialog box Setting Simulation (see Section 5.1), let mu or delta equal the value 
that maximizes the probability of discordance (discussed above). Click Select Set 
only once to select one data set. After selecting New in the dialog box Plot 
Simulation, you can get a new sample path in the window Graphic Window: Plotting 
each time you click Refresh Plot. Assume rho_max = 0.0053 and suppose you have 
clicked Refresh Plot repetitively 100 times. The number of incidences of 
discordance happened among the 100 sample paths is random, on average, equal 
to k × rho_max = 100×0.0053 = 0.53. In other words, you need to simulate 200 
sample paths in average to get one incidence of discordance as the one shown in 
the figure above. 
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5.3 Saving Simulated Data 
 
After did simulation as in Section 5.2, click text in the 4th panel to open a text 
window labeled Text Window: Save and Import Data.  If the graphic window Graphic 
Window: Plotting is open, click the drop-down menu Window → Text Window to switch 
the graphic window to a text widow Text Window: Save and Import Data. From the text 
window, click the drop-down menu Applications → Save Simulation to open a 
Microsoft dialog box Save As. Select a directory and enter a file name, and click 
Save to save the simulated data into a text (.txt) file. The data will be displayed in 
the text window simultaneously if the size of data is large. The data can not be 
shown in the text window if the size is large. If the size is large but not larger than 
200k, then the data is saved, however, an external text editing tool such as 
Notepad, WordPad, or Microsoft Word is required to view it. In a simulated data 
set includes 7 (variables in) columns: 1) ordinal numbers of simulated sets; 2) 
ordinal numbers of observations (within a set); 3) simulated observations (in 
original scale); 4) information times (of observations within a set); 5) standard 
deviation (of distribution used for simulating a set of observations); 6) delta (the 
standardized mean parameter used for simulating a set of observations); and 7) 
mu (the mean parameter used for simulating a set of observations). 
 
5.4 Restarting Simulation  
 
If you are doing simulation and then changed the design parameters in the 2nd 
panel, then you have to update sequential boundaries and setting of simulation 
before starting new simulations. Click Enter Group Sizes or Enter Information Times in 
the 3rd panel of the main dialog box to update group sizes or information times; 
click button Bound-Coeff to recalculate the boundary coefficient a. In the 4th panel, 
click Sequential Design to update the Actual Sig-level and Actual Power for the 
sequential test design. Click Simulated to open the dialog box Setting Simulation, in 
which click Reset and then enter new choices of mean parameter and number of 
observations for each set, and click Select Set repetitively to select sets for 
simulation. After all steps above, you are ready to simulate new sample paths with 
updated designs and parameters by clicking Graphic in the 4th panel. 
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6. Graphic Display 
 

6.1 Sequential Boundaries  
 
Refer to Section 2.3 for the steps to display the sequential boundaries. In the plot 
of sequential boundaries, the x-axis of the plot is presented with two scales: one is 
by the cumulative sample sizes; another is by the information times. The 
information time at each look is the ratio of the cumulative sample size at this look 
to the planned total sample size. The y-axis of the plot is presented in two scales: 
the scale on the right side of the plot is for the original test statistic 

kn
S , which is 

the sum of nk original observations collected by the kth look. The scale on the left 
side of plot is for the standardized test statistic *

kt
S , which equals 

kn
S  divided by 

2/1

Kn  which is the standard deviation of 
Kn

S  at the final stage K. The tk = nk/nK is 

the information time at the kth look, and σ is the standard deviation of the original 
observation. The nK (= m) is the sample size at the planned end of the sequential 
test. At the kth look, the mean and variance of 

kn
S are nkμ and nkσ2, respectively; 

the mean and variance of *

kt
S  are kt  and tk, respectively. 

 
6.2 Power Function 
 
Refer to Section 2.4 for the steps to display the power function. In the plot of 
power function, the x-axis of the plot is for the mean parameter, which is 
presented with two scales: one is for mean of original observations; another is for 
the mean of standardized observations. The ratio of the scale for original data to 
the scale of standardized data is equal to σ/m1/2. The power function of the 
sequential design is presented by the pink curve. The mean parameter under Ha is 
marked on the vertical blue dotted line with the two scales. The significance level 
and power for the fixed sample test design are marked by the two horizontal blue 
dotted lines. 
 
6.3 Expected Sample Size   
 
Refer to Section 2.5 for the steps to display the expected sample size. In the plot 
of expected sample size, the x-axis of the plot is for the mean parameter, which is 
presented with two scales: one is for mean of original observations; another is for 
the mean of standardized observations. The ratio of the scale for original data to 
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the scale of standardized data is equal to σ/m1/2. The y-axis of the plot is 
presented with two scales: the scale on the right side of the plot is by the sample 
size; the scale on the left side of the plot is by the information time. The pink curve 
is the expected sample size as a function of mean parameter in the two scales. 
The mean parameter under Ha is marked on the vertical blue line with the two 
scales. The expected sample size under H0 (mu = 0 or delta = 0) and Ha (mu = mu_a 
or delta = delta_a) can be visually identified from the plot. 
 
6.4 Simulated Data   
 
Refer to Section 2.6 for the steps to display the simulated data, and then refer to 
Section 5.2 for more detailed instructions. In the plot of simulated sample paths, 
the x-axis of the plot is presented with two scales: one is by the cumulative 
sample sizes; another is by the information times. The y-axis of the plot is 
presented with two scales: one is for the original test statistic Snk, which is the sum 
of nk original observations by the kth look; another is for the standardized test 
statistic *

kn
S  which equals Snk divided by (nK)1/2σ, the standard deviation of SnK at 

the final stage K. The tk=nk/nK is the information at the kth look, and σ is the 
standard deviation of the original observation. The nK (= m) is the sample size at 
the planned end of the sequential test.  A simulated sample path can be 
interpreted in either of the two scales. 
 
6.5 Imported Data   
 
For a clinical trial or an experiment designed with SCPRT, sequentially collected 
data can be displayed graphically against the sequential boundary for a visual 
monitoring of the trial or experiment. If there are several variables in the trial or 
experiment, the sample paths for all variables can be displayed in a same plot. To 
display imported data, you first need to design sequential boundaries; second, to 
import the data from a text window; third, to select sets from the imported data for 
simulation; and finally, to display the selected sample paths. 
 

 Designing Sequential Boundaries: Refer to Sections 2 and 3 for the 
steps to design the sequential boundaries. If you want to represent two or 
more variables from an observed data (see Note 1 below) in the same plot, 
then enter four parameters in the 2nd panel of the main dialog box: the 
significance level, the power, the (maximum) sample size (same for all 
variables), and the standard deviation (let it equal 1). Then click Alternative 
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mu_a to calculate the mean parameter. For each set, observations will be 
rescaled by being divided by the assumed or estimated standard deviation 
of the set, by which the standard deviation of rescaled observations from 
each set equals one. 

 
 Import Data: Refer to Section 5.2 for the steps to open a text window Text 

Window: Save and Import Data. From this window, click the drop-down menu 
Applications → Import Data → Sample → Simulated or Observed to open a 
Microsoft dialog box Open. From this box, find the (.txt) file of your interest 
and then click “Open” to import a simulated data or an observed data (see 
Note 1 below). Once imported, the data will be listed in the text window if the size of the 
data is not too large. If the data does not appear in the text window, it could be due to the 
large size of data. If the size of data not exceeding 200k, then plots of the data still can be 
displayed in the graphic window, even though the data did not appear in the text window. 
The observed data should be preprocessed according to Note 2 below. For 
an imported data, you may import variable names for the columns of data. 
To import the list of variable names, from the text window you click the 
drop-down menu Applications → Import Data → Variable Names to open a 
Microsoft dialog box Open from which you can open a (.txt) file that contains 
a list of variable names for the imported observed data (see Note 1 below). 

 
 Select Sets: Click Imported in the sub-panel Select Samples of the 4th panel to 

open a dialog box Import Samples as below. If the button Imported is gray (not 
responsive to clicks), then you need first to import the data using the 
procedure above. 
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In the dialog box Import Samples, click Select Set to select sets from imported 
sets for display. The ordinal number of an imported set is indicated by k = in 
the panel Imported Sample. The ordinal number of a selected set is indicated 
by k = in the panel Selected Sample. The total numbers of imported sets and 
selected sets are indicated by the two numbers in the panel Total Sets. Click 
Selected Sample and then click Delete Set to delete a set, the ordinal number 
of which is prefixed by k =, from the selected sets. The assumed or 
estimated standard deviation (prefixed by SD =) and sample size (prefixed 
by n =) for each imported or selected set are shown in the panel Parameter. 
For each set, the assumed SD came with the imported list of variables, and 
the estimated SD is computed from observations from the imported data. 
Select Assumed: SD = or Estimated: SD =, depending on whether the standard 
deviation is assumed or estimated for each set selected. 

 

 To display: Open the graphic window by clicking Graphic in the 4th panel, or 
switch the open window from a text widow (Text Window: Save and Import Data) 
to a graphic window (Graphic Window: Plotting) by clicking the drop-down 
menu Window → Graphic Window. From the graphic window, click the drop-
down menu Applications → Plot Samples… → Imported Data to open a dialog 
box labeled Plot Imported…. 

 

 
 

In the dialog box Plot Imported…, select All and then click Refresh Plot. All 
imported sets of sample paths will be displayed in Graphic Window: Plotting. 
Selecting Selected, click “Refresh Plot” to display only sets of sample paths 
previously selected through the dialog box Import Samples shown above. 

 
Note 1: The imported data can be a data that was simulated and saved using this 
computer program, or a real data from clinical trials or experiments. We call the former 
a simulated data, and the latter an observed data. For a simulated data, the true 
mean and standard deviation of each set are known, and there are 7 columns (see 
Section 5.3). For an observed data, the true mean and standard deviation of each set 
are unknown, and there are only 3 columns: 1) the ordinal number of set (or path); 2) 
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the ordinal number of observation (in each set); 3) the observation (in original scale). 
An example for the data structure of file for observed data is given as below. 

   1       1       2.74100 
   1       2      -2.82478 
    :        :        : 
   2       1       1.24490 
   2       2      -0.04851 
    :        :        : 
   3       1       0.49472 
   3       2       0.79912 

The file above can include only numerical items. If you want to display variable names 
for the variables of an imported observed data, then you need to import them from a 
separate .txt file which contains 3 columns: 1) the ordinal number of imported set; 2) 
the variable names of imported set; 3) the standard deviation of imported set. An 
example for the data structure of the file for variable names is given as below. 

1    name_variable_one     2.0 
2    name_variable_two     1.5 
3    name_variable_three  1.0 

The total number of sets should be the same for the two files. 
 

Note 2: For each set or variable in the observed data, if the hypothesis is H0: μ ≤ μ0 vs. 

Ha: μ > μ0, then the imported observations should be 0

*  ii XX , where *

iX  is the 

original observation from trial or experiment. If the hypothesis is H0: μ ≥ μ0 vs. Ha: μ < 
μ0, then the imported observations should be 0

*  ii XX . 

 
7. Comparison of Two Populations 
 
The SCPRT procedure described above is about one-population comparison, in 
which an unknown mean is compared to a known constant. For comparing the 
means of two populations, we can easily transform the problem to one-population 
comparison by comparing the difference of two means to 0. However, the 
calibration of information times for interim analyses may not be in the simple form 
of proportions on cumulative sample sizes of interim analyses to the total sample 
size at the planned end. The sequential test statistic and information times of looks 
are given in section 7.1 for comparing two normal populations, in section 7.2 for 
comparing two binary populations, and in section 7.3 for comparing two survival 
populations. To obtain the sequential boundaries, critical p-values, and other 
operating characteristics for the sequential test statistic in these situations using 
this computer program are demonstrated in section 7.4. 
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7.1 Two Normal Populations 
 

Let μ1 and μ2 be the unknown means, and 2

1 and 2

2  known variances, of two 
normal distributions. The hypothesis H0: μ1 ≤ μ2 vs. Ha: μ1 > μ2 is equivalent to H0: 
d ≤ 0 vs. Ha: d > 0, where d = μ1 - μ2. Suppose you want to test the hypothesis with 
significance level α and power 1-β to detect a given da (> 0). For a fixed sample 
test, the sample size is 22

2

2

1

2

1 /)()( adrzzm    for the first population (X1), 

and is rmm /12   for the second population (X2), where r is a number specified by 
the user as the ratio of two sample sizes. If you want to minimize the total sample 
size 21 mmm  , then you may choose 21 /r . If you want to minimize the total 

cost of accruals, 21 cmmC  , then you may choose 21 /cr  , where c is the 
proportional cost of individual accrual for X2  assuming the cost for X1 is 1. For the 
sequential test, let kn1 and kn2 be sample sizes of two populations at the kth look; 

assume rnn kk 21 /  for all ,,,1 Kk   where K is the total number of interim and 

final looks. The kn1 ’s are specified by you, the designer of study, and the kn2 ’s are 

calculated by kk rnn 12  . Let 2/1* / Kkt VUS
k
 , where  


kk n

j j

n

j jk XrXU
21

1 21 1 , and 

)( 2

2

2

11  rnV kk  . Then the hypothesis of interest became H0:  0  vs. Ha: 0  

with the sequential test statistic *

kt
S distributed with ),( kk ttN  , where Kkk nnt 11 / , 

11 mn K  , and addzz /)(   .  

 
For example, assuming 11   and 2.12  , and 1c , let 6/5r  which 
minimizes the total sample size. Assume with significance level 05.0  and 
power 85.01    to detect a difference of 5.0ad . The calculated sample size is 

27.631 m  for X1, and 92.752 m  for X2; hence 641 m  and 762 m  by being 
rounded up to the nearest integers. Assume 4K  and the cumulative sample 
sizes for the first population at the four looks are assigned as 1511 n , 3012 n , 

4513 n , and 6414 n , then the cumulative sample sizes for the second population 

at the four looks are 1821 n , 3622 n , 5423 n , and 7624 n , calculated by 

5/6/ 112 kkk nrnn   for k =1, 2, 3, and 4. The information times are 0.2343751 t , 

0.4687502 t , 0.7031253 t , and 14 t , calculated by 141 / nnt kk   for k =1, 2, 3, 4. 
Under Ha, the parameter of drift for Brownian motion to be detected with power 

85.01    is 2.6968a , calculated by 2/12

2

2

11 )]/([  rmdaa  . If 1m  is not 

rounded up, then  zza  .  
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7.2 Two Binary Populations 
 
Let p1 and p2 be the parameters of response for two binary distributions, 
respectively. The hypothesis H0: p1 ≤ p2 vs. Ha: p1 > p2 is equivalent to H0: d ≤ 0 vs. 
Ha: d > 0, where d = p1 – p2. Suppose you want to test the hypothesis with 
significance level α and power 1-β to detect a given da (> 0). For a fixed sample 
test, the sample size is 2

2222

2

1 /)]1()1)([()( aaa dprpdpdpzzm    for the 

first population (X1), and is rmm /12   for the second population (X2), where r is 
the ratio of two sample sizes, a number specified by user. If you want to minimize 
the total sample size 21 mmm  , you may choose 

)1(/)1)(( 2222 ppdpdpr aa  . If you want to minimize the total cost of 

accruals, 21 cmmC  , you may choose )1(/)1)(( 2222 ppdpdpcr aa  , 

where c is the proportional cost of individual accrual for X2  assuming the cost for 
X1 is 1. Let kn1 and kn2 be cumulative sample sizes of two populations at kth look of 

a sequential test. Assume rnn kk 21 /  for all ,,,1 Kk   where K is the total 

number of interim and final looks. Assume kn1 ’s are specified, and kn2 ’s are 

calculated by rnn kk 12  . Let 2/1* / Kkt VUS
k
 , where  


kk n

j j

n

j jk XrXU
21

1 21 1 and 

))1()1)((( 22221 prpdpdpnV aakk  . The hypothesis of interest is now H0:  

0  vs. Ha: 0  with the sequential test statistic *

kt
S distributed approximately 

with ),( kk ttN  , where Kkk nnt 11 / , 11 mn K  , and addzz /)(   . 

 
For example, assuming significance level 05.0  and power 85.01    for 
detecting a difference of 2.0ad . Assume nuisance parameter 6.02 p  and 1c ; 

8165.0r  minimizes the total sample size; hence let 5/4r  for simplicity. The 
calculated sample size is 27.631 m  for X1, and is 08.792 m  for X2; hence 641 m  
and 802 m  by rounded up to the nearest integers. Assume 4K  and the 
cumulative sample sizes for the first population at the four looks are 1611 n , 

3212 n , 4813 n , and 6414 n , then the cumulative sample sizes for the second 

population at the four looks are 2021 n , 4022 n , 6023 n , and 8024 n , 

calculated by 4/5/ 112 kkk nrnn   for k =1, 2, 3, and 4. The information times are 

0.21 t , 0.42 t , 0.83 t , and 14 t , calculated by 141 / nnt kk   for k =1, 2, 3, and 4. 
Under Ha, the parameter of drift for Brownian motion to be detected with power 

85.01    is 2.6968a  by 2/1

22221 ))]1()1)(/(([ prpdpdpmd aaaa  . 
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 7.3 Two Survival Populations 
 
Let 1  and 2  be hazards of survival functions )(1 tG  and )(2 tG  for two populations,  

1X  and 2X ,  respectively. Let 12 /r be the hazards ratio and assume r  is a 
constant independent of time, which means that 1  and 2 should be proportional 
to each other if 1  and 2  are functions of time t .  The hypothesis of interest is H0: 
r ≤ 1 vs. Ha: r >1 with significance level α and power 1-β to detect a given 
alternative ar . Let 1m and 2m  be the samples sizes of the two populations, and let 

)/( 211 mmm  and )/(1 212 mmm   be proportions of the two groups. Let  
)}()5.0(4)({ 1116

1 faGfaGfGA  , )}()5.0(4)({ 2226
1 faGfaGfGB  , 

where a  is the length of enrollment period and f  the length of followup period in 
the clinical trial, for sample size calculation assuming they are the same for both 
groups. The sample size for the first group is )1/(21   mm , and the sample size 

for the second group is }))))(ln((1(/{)( 22

2 arBABzzm   . You may 

choose   )(3)()1)(1(21 2 BABABAAB   if you want to minimize 

the total sample size 21 mmm  . Assume distinct event times across two groups 
are j  21 , where the event time is defined as the length of time from 

the accrual to the event for a patient. At time j , let jd1  be the number of events 

from the first population and jd 2  the number of events from the second population. 

Let jn1  and jn2 be numbers of subjects at risk just before time j from the two 

populations. Consequently, jjj ddd 21   is the total number of events at time j  

among a total of jjj nnn 21   subjects just before j , and jjjj ndne /11  . Let 

)(* k be calendar time at the kth look, at which the log-rank score is 

)(
)(1)(1 ** 

j
kjkjk edU


, where 

)(1 * kj
d


, 

)(1 * kj
e


, 

)(1 * kj
n


, 

)(2 * kj
n

 )(* kj
d


, and 

)(* kj
n


 are 

those as jd1 , je1 , jn1 , jn2 jd , and jn  but calculated from the data up to )(* k . Let 

)1(/)(
)(

2

)()()()()(2)(1)(1 ******** 
kjkjkjkjkjkjkjkj

nndndnnv
k 

, then the variance of kU  

is 
j

kjk vV
)(1 *
. The sequential test statistic is ** / Kkt VUS

k
  for 1,,1  Kk , 

where 2* )}/(ln(){( aK rzzV   ; */ Kkk VVt   is the projected information time and 
*

KV is the projected variance of KU . At the final stage K , the true variance KV  is 

used instead of *

KV , hence 1Kt  and KKt VUS
K

/*  . The information time kt  is 
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not specified in advance but calculated from kV  with data up to the stage k , with 
all looks determined according to the calendar time or the number of subjects 
enrolled since the start of clinical trial.  
 
For example, assume )exp()( 11 ttG   and )exp()( 22 ttG  , and with significance 
level α = 0.05 and power 1-β = 0.80 to detect 6.1ar  ( 12 /r ) under Ha. 
Assume the accrual period is from 0 to 4th year, and the follow-up period is from 4th 
year to 5th year, of study; thus 4a  (years) and 1f  (year). Assume a nuisance 
parameter 2.02   ( 5/1 222  EX ), then under Ha, 125.0/21  ar  

( 8/1 111  EX ), hence A=0.6945 and B=0.5636. The total sample size 

21 mmm   can be minimized by 457.0 . Let 5.0  for the simplicity of 
balanced sample sizes, the calculated sample sizes are 9.15021  mm ; hence 

15121  mm  by rounded up to the nearest integers. Assume looks are planned at 
the 2nd, 3rd, 4th, and 5th years from the start of trial. Information time kt  of the kth 

interim analysis will be calculated from data for 4,,1k . 
 
7.4 Sequential Boundaries 
 
For any sequential test statistic that behaves like a Brownian motion on the 
information interval [0, 1], including those in Sections 7.1, or 7.2, or 7.3, the 
SCPRT sequential boundaries and critical p-values can be obtained as following. 
For illustrative purpose, we will use the numerical example in Section 7.1 for 
comparing two normal populations.  
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In the 1st panel of the main dialog box labeled SCPRT on Information Time, click the 
button SCPRT on Information Time. In the 2nd panel, enter 0.05 for Sig-level and 0.85 
for Power of Test. In the 3rd panel, enter 4 for Number of Looks, and then click the 
button Enter Information Times to open a dialog box labeled Information Times as 
above. In this dialog box, change the default information times to the values of 

0.2343751 t , 0.4687502 t , 0.7031253 t for the first three looks calculated in 
Section 7.1, and then click the buttons Update Changes and Keep Changes. The 
updated information times of looks should be as that in the dialog box above. Click 
the button OK to close the dialog box and return to the main dialog box. Remember 
to click the button Bound-Coeff a, by which the boundary coefficient is calculated as 
a = 2.9420, and the maximum probability of discordance is calculated as ρmax = 0.0056. 
In the 4th panel, click the button Sequential Design to calculate the significance level 
and power of the sequential design, which are α = 0.0511 and 1-β = 0.8489. In the 
sub-panel Window, click the button Graphic to open a graphic window Graphic 
Window: Plotting. In this window, select Applications → Plot Design… → Sequential 
boundary from drop-down menus to open a small dialog box Plot. By clicking the 
button Refresh Plot in the box, the system will plot the sequential boundaries, as 
shown below, with the critical P-values for upper and lower boundaries listed in the 
plot. The critical p-values listed in the plot are 

ka
p ’s = (0.0018, 0.0019, 0.0035, 0.05) 

for upper boundaries and 
kb

p ’s = (0.9076, 0.7395, 0.4470, 0.05) for lower boundaries, 

respectively, for reaching significance and futility. In the plot, 2.681a  calculated 

by  zza  , which differs slightly from 2.6968a  calculated in Section 7.1. 

The former is calculated using sample size 27.63141  nm , and the latter is 
calculated using 64141  nm  which is the actual sample size used in trial. 
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Click Critical Boundary Values in the 5th Panel of the main dialog box, the sequential 
boundaries for *

kt
S ’s are obtained as (1.413, 1.9815, 2.2648, 1.6449) and (-0.642, -

0.4395, 0.0483, 1.6449), respectively, for upper and lower boundaries. The critical p-
values and the sequential boundaries for 

kn
S ’s are presented as well in the dialog 

box. At the kth look, the observed P-value 
kS

p  can be obtained as the p-value from 

regular non-sequential test of comparing two populations applying to data 
collected up to stage k . If 

kS
p  is less than or equal to 

ka
p , or greater than or equal 

to 
kb

p  at some stage k  for the first time, then the trial can be stopped. The power 

function, the probability of discordance, and the expected information time of 
SCPRT design can be obtained with similar procedures by clicking other three 
buttons in the 5th Panel: Probability of Significance, Probability of Discordance, and 
Expected Sample Size, respectively. 
 
8. Comparison with Historical Population 
 
The SCPRT procedure for comparing a current population with a historical 
population is similar to that for comparison of two current populations in Section 7.  
The main difference distinguishing this situation from the previous one is that the 
samples for the current population (X1) are collected and sequentially compared at 
each look of the study with all samples from the historical population (X2). The 
SCPRT procedure for this situation differs from that in Section 7 in three aspects: 
1) calculation of sample size (see Section 8.1); 2) definition of sequential test 
statistic (see Section 8.2); 3) calculation of information time (see Section 8.3). 
 
8.1 Sample Size Calculation 
 
There are two scenarios for sample size calculation for design of comparison with 
historical population. The first scenario is the conventional way of comparing two 
means, namely, to detect 21   aad  with power 1-β. The sample size of the 

historical population 2m  is given. The sample size for the current population for 

normal populations is by ]/)/(/[ 2

2

2

222

11 mzzdm a    , and that for binary 

populations is by ]/)1()/(/[)1)(( 222

22

221 mppzzddpdpm aaa   . For 

survival populations, )1/(21   mm , where 2m  is given and   is the solution of 
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equation }))))(ln((1(/{)( 22

2 arBABzzm   ; or equivalently, 

   BArmzzBABB a  2))(ln(/))((4)1(1 2

2

22

 .  

 
The second scenario is to detect alternative 21

ˆˆ   aad  with power 1 . Since 

the mean of historical controls had already been estimated by 22
ˆ X  prior to the 

current study, and investigators may take it as a priori information for design of the 
trials. The appeal of the scenario is that the alternative hypothesis with a1  against 

a visible 2̂  rather than an invisible 2  sometimes conveys important practical 
information. For the normal populations, with the sample size of the historical 
population 2m  given, the sample size 1m  for the current population for the current 

study is the solution of equation Rzmdz a  1/ˆ
11   , where 

)//()/( 1

2

12

2

2 mmR   is a function of 1m . Equivalently, the sample size can be 

calculated by    
2

2

222

2

2

2

222

211
ˆ/1ˆ/)(1ˆ/






 




  mdzdmzzzzdm aaa   . For the 

binary populations, 
 22

2

22

2
2

2

22

2222

1
ˆ/)1(ˆ

ˆ/))(1(1)ˆ1)(ˆ(

aa

aaa

dmzppd

dmzzppzzdpdp

m












 

 . The 

1m  obtained from the second scenario is smaller than that obtained from the first 
scenario. However, the SCPRT procedure and the sequential test statistic are the 
same for the two scenarios. 
 
8.2 Sequential Test Statistic 
 
For normal populations, the sequential test statistic is defined as  

 








k

k

n

i

i

k

t XX
mnRm

R
S

1

21

111

*

))/(1(

1


, where iX1 ’s are observations from the 

current population, and 2X  is the sample mean of all data from the historical 
population.  For binary populations, the sequential test statistic is the same as 

above equation except that 1  is replaced by )ˆ1)(ˆ( 22 aa dpdp  . For the 

survival populations, similar to that in Section 7.3, the sequential test statistic is 
** / Kkt VUS

k
 for 1,,1  Kk , where )(

)(1)(1 ** 
j

kjkjk edU


, 
j

kjk vV
)(1 *

, 

2* )}/(ln(){( aK rzzV   , ** / Kkk VVt  (see Section 8.3); )(* k  is the calendar time at 
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kth look. In equation )1(/)(
)(

2

)()()()(2)(1)(1 ******* 
kjkjkjkjkjjkjkj

nndndnnv


, the 

component items different from those in Section 7.3 are jkjkj
ddd 2)(1)( ** 


, 

jkjkj
nnn 2)(1)( ** 


, 

)()()(1)(1 **** /
kjkjkjkj

ndne


 . Same as in Section 7.3, the true 

variance KV  at the final stage K  is used instead of *

KV , and hence 1* Kt  and 

KKt VUS
K

/*  . The transformed information time *

kt  is not specified in advance 

but calculated from kV  with data collected up to the kth look. The looks are 
determined according to the calendar time of study or the number of patients 
enrolled since the start of clinical trial.  
 
8.3 Transformed Information Time 
 
For comparison against historical data, the original information time measures the 
information accumulation for data from the current population, and the transformed 
information time measures the information accumulation for data from both current 
and historical populations.  For normal and binary distributions, the original 
information time at the kth look is Kkk nnt 11 / , and the transformed information 

time is )1/()1()(**

kkkk RttRttt  , where )//()/( 1

2

12

2

2 mmR   for normal 

distribution and    122222 /)ˆ1)(ˆ(/)1(( mdpdpmppR aa   for binary distribution. 
For survival populations, the information time can not be predetermined but be 
calculated from data at each look. As shown in Section 8.2, the transformed 
information time *

kt can be directly estimated from data at the kth look, thus does 

not need to be transformed from the original information time kt which is also 
random and needs to be estimated from data at the kth look. The presentation and 
calculation of sequential boundaries are much simpler by using the transformed 
information time. 
 
8.4 Sequential Boundaries 
 
For a sequential test statistic defined in Section 8.2, the sequential boundaries and 
critical p-values can be obtained by follow steps in Section 7.4. However, the 
information times entered in the program procedure should be the transformed 
information time defined in Section 8.3. 
 
Example for normal populations: To test hypothesis H0: μ1 ≤ μ2 vs. Ha: μ1 > μ2, 
assume 11  , 5.12  , 1482 m , and 0337.0ˆ

22  X .  With significance level 
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05.0  and power 80.01    to detect a difference of 4.0ad  (for the first 

scenario), we have 1001 m and hence 584507.1R . Assume 4K  and at the 4 
looks the cumulative sample sizes are 100,75,50,25,, 1411 nn  for the current 

population. The original information times are 1,75.0,5.0,25.0,, 41 tt , and the 

transformed information times are 1 0.88576, 0.72102, 0.46280,,, *

4

*

1 tt  calculated 

by )1/()1(*

kkk RttRt  . Referring to Section 7.3, in the 1st panel of the main 
dialog box SCPRT on Information Time, click the button SCPRT on Information Time. In 
the 2nd panel, enter 0.05 for Sig-level and 0.80 for Power of Test. In the 3rd panel, 
enter 4 for Number of Looks, and then click the button Enter Information Times to open 
a dialog box labeled Information Times. In this dialog box, change the default 
information times to the values of 0.462801 t , 0.721022 t , 0.885763 t  for the first 
three looks in Section 7.1, and then click the buttons Update Changes and Keep 
Changes. Click the button OK to close the dialog box and return to the main dialog 
box labeled SCPRT on Information Time. Set ρ=0.03 and click the button Bound-Coeff a, 
by which the boundary coefficient is calculated as a= 2.582826 and the maximum 
probability of discordance is calculated as ρmax=0.0056.  

 

 
 

In the 4th panel, click the button Sequential Design to calculate the significance level 
and power of the sequential design, which are α = 0.0507 and 1-β = 0.7993. In the 
sub-panel Window, click the button Graphic to open a graphic window Graphic 
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Window: Plotting. In this window, select Applications → Plot Design… → Sequential 
boundary from drop-down menus to open a small dialog box Plot. After clicking the 
button Refresh Plot, the system will plot the sequential boundaries, as shown above, 
with listed the critical P-values for upper and lower boundaries. The critical p-
values are listed in the plot as 

ka
p ’s = (0.0027, 0.0047, 0.0103, 0.05) on upper 

boundaries and 
kb

p ’s = (0.7078, 0.4222, 0.2177, 0.05) on lower boundaries, 

respectively, for significance and futility.  
 
An example for binary populations: To test hypothesis H0: p1 ≤ p2 vs. Ha: p1 > p2, 
we assume 352 m  and 62857.0ˆ

22  Xp . With significance level 05.0  and 

power 82.01    to detect a difference of 2.0ˆ ad  (for the second scenario), we 

have 621 m  and hence 9117.2R . Assume 4K  and the cumulative sample 
sizes of current population at 4 looks are 62,43,32,24,, 1411 nn . The original 

information times are 1,6935.0,5161.0,3871.0,, 41 tt and the transformed 

information times are calculated as 1,8985.00.8067, 0.7118,,, *

4

*

1 tt .  
 

 
 

Follow the steps of computer program for the example above and set α = 0.05 and 
1-β = 0.82 in the second panel, and ρ = 0.04 in the second panel, of the main dialog 
box. We have boundary coefficient a = 2.22137 and the maximum probability of 
discordance ρmax = 0.0057. In the 4th panel, the significance level and power are α = 
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0.0505 and 1-β = 0.8195, updated by clicking the button Sequential Design. The 
sequential boundaries are plotted as above, and by which the critical P-values are 

ka
p ’s = (0.0059, 0.0081, 0.0129, 0.05) on upper boundaries and 

kb
p ’s = (0.3989, 

0.2909, 0.1874, 0.05) on lower boundaries, respectively, for significance and futility.  
Click Critical Boundary Values in the 5th Panel, the sequential boundaries for 

kt
S ’s 

are obtained as ),,(
41 tt aa  (2.1255, 2.1592, 2.1144, 1.6449) and ),,(

41 tt bb  

(0.2161, 0.4946, 0.8414, 1.6449) for upper and lower boundaries, respectively. Let 





k

k

n

i

k

X

n XS
1

1

1

1

1  be the number of responses in kn1 binary observations from the 

current population at the kth look. Then the sequential boundaries for 1

1

X

n k
S  are 

 ][*

kk aa  and  ][*

kk bb for upper and lower boundaries, respectively, where 

2111122 1/)/1()1)(( XnRmRnmdpdpaa kkaatk k
  and 

2111122 1/)/1()1)(( XnRmRnmdpdpbb kkaatk k
 ; ][x  is the smallest 

integer greater than or equal to x ; and ][x  is the largest integer less than or equal 

to x . For this example, the sequential boundaries for 1

1

X

n k
S ’s are ),,( *

4

*

1 aa  (22, 29, 

37, 49) as the upper boundaries for significance, and ),,( *

4

*

1 bb  (15, 21, 30, 48) as 

the lower boundaries for futility, with partial cumulative sample sizes ),,( 1411 nn (24, 32, 
43, 62) at the four looks. 

 
An example for survival populations: Assume the survival functions are 

)exp()( 11 ttG   and )exp()( 22 ttG   for current population and historical 
population, respectively. To test hypothesis H0: r ≤1 vs. Ha: r >1 ( 12 /r ) with 
significance level 05.0  and power 80.01    to detect alternative 6.1ar  (for 

the first scenario), we assume 1402 m  for the sample size for the historical 
population, and 4a  (years) and 1f  (year) for the durations of accrual and 
follow-up, respectively. Assume the nuisance parameter 2.02  , then 125.01   
under Ha and thus 1701 m . Assume looks are planned at the 2nd, 3rd, 4th, 5th years 
from the start of trial. Information time kt  is not specified by be calculated from data 

at the kth interim analysis for 4,,1k . For example, by simulation with 
parameters set under Ha by letting 2.02   and 125.01  , we have the 

transformed information times ),,( *

4

*

1 tt (0.349, 0.594, 0.835, 1.0). Follow the steps 
in computer program for the two examples above in Section 8.4, enter these 

*

4

*

1 ,, tt  and set ρ= 0.03, we have boundary coefficient a= 2.584797 and the maximum 
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probability of discordance ρmax=0.0069. In the 4th panel, the significance level and 
power are α = 0.0510 and 1-β = 0.7989. The sequential boundaries are plotted as 
below, and the critical P-values are 

ka
p ’s = (0.0025, 0.0033, 0.0076, 0.05) on upper 

boundaries and 
kb

p ’s = (0.8059, 0.5718, 0.2811, 0.05) on lower boundaries, 

respectively, for significance and futility. Click Critical Boundary Values in the 5th 
Panel, the sequential boundaries for *

kt
S ’s are obtained as ),,( *

4
*
1 tt

aa  (1.6578, 

2.0936, 2.2174, 1.6449) and ),,( *
4

*
1 tt

bb  (-0.5097, -0.1395, 0.5295, 1.6449) for upper 

and lower boundaries, respectively. 
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